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Goal:  Create a scenery for Harris Hill Soaring Corporation.
This tutorial will take you thru all the steps that were used to create a scenery for Harris Hill Soaring in 
Elmira, NY.   The home of Soaring in the United States and the location of Schweizer Aircraft.   In this 
case we’ll be creating a 57x57 mile landscape with the Harris Hill airfield (4NY8) at the center.

You don’t have to be a graphics expert to create your own scenery.  We’re constantly updating this 
document with step-by-step instructions and also using better automation from some of the complex 
steps.   If you have any problems, don’t hesitate to contact us. At the end of this tutorial we’ll have 
flyable scenery with 3-D terrain which has been overlaid by photo scenery. 

Part One:  Creation of 3-D terrain
This part will first get your computer setup for landscape creation with the needed landscape creation 
tools and documentation.   We’ll then go thru the steps necessary to create a flyable 3-D terrain of the 
correct size

Step Zero:   Download the tools and guides needed

If you’re a Mac/Apple person, sorry, most of these tools run under Windows.  Graphics processing is a 
difficult task for a PC.  You should have a reasonably fast processor and at least 8 gigabytes of RAM 
and room on your hard drive.  A completed scenery can easily use several gigabytes of disk space.

1) Download the Condor Landscape tool set (CLT 2.0) and documentation for landscapes from the 
condorsoaring.com site, unpack in a different directory from where Condor 2/3 is installed.  We 
recommend you place it in a folder called ‘condor’ for ease of reference.
NOTE: Landscapes created with the Condor 2 toolkit are mostly compatible with Condor 3.  
Exceptions will be noted in this tutorial (look for red text).

2) Download a legacy texture tool from Nvida that will be needed.  Unpack the zip in the same 
directory where you installed the landscape editor above.  When you are done the LandscapeEditor.exe 
and nvdxt.exe should be in the same folder.

3) Download wget.exe and place it in a folder called  C:\Programs\wget (you will probably need to 
create the C:\Programs folder and the folder C:\Programs\wget).

4) Download 7zip and run the install program, accept the default location.

5) Download an additional compression tool, Compressonator.  Unzip the file to the same directory as 
the Landscape Editor.

6) Download and install the QGIS program version 2.18.28,  We won’t use most of it, but one of the 
utilities it contains will be used by Condor_tiles later.  Although there are newer versions of this 
software, make sure you get version specified.
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7) Download and install Google Earth Pro for the desktop →  https://www.google.com/earth/versions/ 
Scroll down on the versions page and choose the desktop download.  This is a great tool for 
visualizing/measuring your landscape.

8) Download the Condor_tiles program.  Unzip the file to the same directory as the Landscape Editor. 
It can be found in the downloads section on the SoaringTools web site  → 
http://www.SoaringTools.org/index.php/downloads/

9) You can now download some updated files used in scenery creations.  After download you want to 
unpack them in the same folder where you unpacked Condor_tiles.  In my case:  
\John\soaringtools\condor\Batch
NOTE:  The “Batch” folder should already be present.  It was created when you unpacked Condor_tiles 
in the step above. You may get a warning that the files already exist in the destination, go ahead and 
allow replacement.

As an example, if you unpacked the Landscape Editor, Compressonator, and Condor_tiles in a folder 
called “condor”.  It should have at least the following contents:

Batch/             Help_Files/           SimpleObjects/  compressonatorcli-4.4.19-win64/

Condor_Tiles.exe  LandscapeEditor.exe  Viewer/         nvdxt.exe

  Step One:  Determine the coordinates for the scenery

Although we will be building the Harris Hill scenery, it’s likely you’re already thinking about 
making a small scenery for your local area. It’s relatively simple to use this tutorial as a model and 
substitute your own area. The steps are the same, just the naming is different. If you’re going to do this, 
it might be good to learn a bit more about the structure of Condor2 sceneries so that you understand 
what is happening at each step (see details in   APPENDIX ONE – General notes on Scenery Creation).

Briefly, the unit of Condor2 scenery is the tile. Each tile is 23 km x 23 km (14.29 mi x 14.29 
mi), and a scenery is a rectangle of row x col tiles. This is important because as you choose the size of 
your initial scenery you want the sides of your rectangle to be multiples of the tile size. Also be aware 
that the outer edge of this rectangle is not usable (approximately ¼ tile), so when you think about your 
coordinates, take into account this margin.

         You can use any map, but Google Earth is very handy.  Take the time to make SURE you get the 
coordinates right. Google Earth makes it easy giving you the decimal coordinates of the Southeast and 
Northwest corners.

You now have a potential area selected. Because the earth is round and our maps are flat, we 
need a way to project that curved surface onto a flat area. The first goal is to determine the 
latitude/longitude of the north west corner and south east corner of your landscape (also know as top 
left  and bottom right). 
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For Harris Hill we want  at least a 9 tile landscape (3 x 3).  Each Condor landscape tile is 
14.2915 miles/23 km square, so we want to have a square app. 42 miles on each side.  Now remember, 

the Earth is not FLAT, so our square is 
approximate and the tools will 
compensate for that. Make sure you 
have a little extra.  Start from you 
center point and measure out 23 miles 
N,S,E,W (46 miles/side)

           If you use another tool, BE 
CAREFUL not to confuse 
Degrees/Decimal minutes/seconds 
below with other format which give 
individual degrees, minutes, seconds.  

Some tools like a certain format – many are happy to take the wrong format and convert to a bad 
location….. beware! This web site is your FRIEND in conversions →   
https://www.pgc.umn.edu/apps/convert/ 

NW Pt:   42°25'26"N / 77°24'26"W or 42°25.438’N / 77°24.434’W or 42.423968 / -77.407247

SE Pt: 41°48'41"N /  76°25'32"W or 41°48.699’N / 76°25.545’W or  41.811661 /  -76.425757

WARNING: Don’t skimp on this step, some bad numbers here will cost you later!  

 

Step Two:  Check layout and confirm proper size

With those corners defined, we now start to build the landscape.  The Lat/Lon we have are 
approximate.  Create a folder in the Condor2\Landscapes directory to hold your scenery.  In this 
case we call it hhsc1 (you can substitute your own scenery name in the examples).

1) Start Condor_Tiles. 
 In the “Landscape” box, choose the folder you just created above. 
 Some settings:  Imagery/Tiles,  Tile Zoom/16, Tile size/8192, GeoData/OSM. DXT/DXT1
 On just the first run you need to define several  paths. Using the ‘...’ buttons to set:

Condor_Path → Set it to the location of your Condor2 install, usually C:\Condor2
Condor LE (Landscape Editor) → Where you installed the Condor landscape toolkit.

GDAL library Path → This is a geodata processing package that was installed as part of QGIS. 
If you’ve installed QGIS 2.18 you should find this path:  C:\Program Files\QGIS 2.18\bin
If you’re having a hard time finding it, do a Windows search for gdalwarp.exe

“DDS Texture” Compressor Path → This should point to the install directory for 
compressonator.
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“Downloader” combiner path → This will become important later when we download satellite 
imagery.  For now just type in the path:  C:\allmapsoft\gsmd   -- we’ll install the software later 
in the tutorial.

Mine looks like this when done. Don’t accept the default values!
  

  

2)   In Condor_tiles click on the “DEM Helper” button (top of the 2nd column on the right side). This 
will bring up a new screen.  Make the following entries:

a) In the upper left “Desired Area Selection” choose “By Coordinates” and enter the values just 
as we recorded earlier.  Use decimal values, latitude for North/South, longitude for West/East.

b) In the bottom left “Range Margin” choose “None” (we should have already compensated that 
the last 5.76Km or 3.6 miles will be unflyable around the border of your landscape. Do not 
check the box “TL BR”

      c)  Then click the box ‘To UTM’.  You will see values fill in the upper right side in the box 
“Condor UTM Range”. 

d) In the upper right click on “Standardize” and then click “Check/Show” and you will see a 
grid pattern in the box labeled “Condor Latitude/Longitude”.    Explanation follows.

The numbers in the upper right box are called Easting/Northing values.  The earth is divided into 60 
UTM zones, HHSC is in 18N, and your exact location in the zone is defined by the Easting(X Coord) 
and Northing(Y Coord).  So the values above express the exact coordinates of the corners and for our 
Condor landscape they need to be on whole numbers.

The bottom right box shows the rounding that occurred.  Our original values (the Blue Box) put us 
closer to a 4x4 terrain.  The outer black grid shows the landscape has been expanded to 4x4.  The red 
box shows the actual flyable area (remember, you can’t reach the edge of a landscape).  We could try to 
shrink it in Latitude and Longitude for a 3x3, but we’ll accept the 4x4. 

GOOD IDEA to take a screen snapshot to you have all the values, including lat/lon of the corners.
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 NOTE:  Your screen layout may a look a little different than above, depending on your version of 
Condor_tiles – but the info should be the same.

3)  In the lower right click on “Make KML” to make a Google-earth map file.  It will be stored in 
Landscapes/hhsc1/working/DEM/OverAllMap/OverAll.kml 
You’ll need Google Earth to open and see the file.  It should agree with what you expect. 
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Step Three:  Download terrain data and create terrain files

1) Click on “Make DEM”  (lower left part of the 
window) while in the “DEM Helper” window to 
create a batch file to run the GDAL library 
routines.  Check the message box in the main 
Condor_tiles window for files you need to 
download.   What’s DEM? → Digital Elevation 
Model

DEM: Will need to download the following 
STRM files:
N41W078.hgt
N41W077.hgt
N42W078.hgt
N42W077.hgt
DEM: Condor V2 batch file created.
DEM: Columns: 3072
DEM: Rows: 3072
DEM: UTM_Zone: 18 N
DEM: UTM_Right: 387456
DEM: UTM_Bottom: 4618673
DEM: 90m Terrain UTM_Right: 387426
DEM: 90m Terrain UTM_Bottom: 4618703 

2) 

At this point some files have been created for your new scenery.  Check the ../Working/DEM folder 
and you see several batch files:  DEM_WGET.bat, DEM_Extract.bat, and DEM.bat.   They contain the 
commands necessary to download the actual 3-D terrain data for the area you specified.

C:\Users\jmurtari>cd \Condor2\Landscapes\<landscape_name>\Working\DEM
C:\Condor2\Landscapes\hhsc1\Working\DEM>dir /w

[.]               [..]              DEM.bat          DEM_Extract.bat   DEM_WGET.bat      
[KML]            LatLong.txt       scenery.hdr       URLs.txt 

3) The scripts will download data from a USGS/NASA website.  It uses Space Shuttle Radar 
Topography Mission data.  Go to →https://urs.earthdata.nasa.gov/home     to register and create a login 
account with NASA. 
  
NOTE:  They require a strong password that includes a ‘special’ character, please use the ‘@’ 
character and not an exclamation point or dollar sign. At times downloads from the USGS servers may 
fail.  They do offer pretty responsive tech support.  If you have a problem, let them know here → 
https://ers.cr.usgs.gov/feedback/

  
4)  In the DEM Helper window press the button labeled “Execute Batch Files”.  You will see a 
command window opened and you will be prompted to enter your username and password for the 
NASA website.
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NOTE: You may get a warning about an unknown program that wants to execute,  allow it.

5) Start a “Command Prompt” window.  After download you should now have this additional contents: 
  

c:\Condor2\Landscapes\hhsc1\Working\DEM>dir (your dir display may have different columns) 
12/18/2023  12:42 PM        10,602,217 N41W077.SRTMGL1.hgt.zip
12/18/2023  12:42 PM        11,545,464 N41W078.SRTMGL1.hgt.zip
12/18/2023  12:42 PM         9,441,928 N42W077.SRTMGL1.hgt.zip
12/18/2023  12:42 PM         9,575,162 N42W078.SRTMGL1.hgt.zip
12/18/2023  12:43 PM               679 UTM_cropped.hdr
12/18/2023  12:43 PM        18,874,368 UTM_cropped.raw
12/18/2023  12:43 PM               604 UTM_cropped.raw.aux.xml
12/18/2023  12:43 PM               683 UTM_cropped_90m.hdr
12/18/2023  12:43 PM         2,097,152 UTM_cropped_90m.raw
12/18/2023  12:43 PM               604 UTM_cropped_90m.raw.aux.xml
12/18/2023  12:43 PM         2,099,695 UTM_cropped_90m.tif
12/18/2023  12:42 PM                34 wget.log
12/18/2023  12:42 PM               104 ZIPs.txt 

6)   Now you can use the two other buttons at the bottom of the DEM helper page. Click on 
“Make Terrain (.TRN)” to generate a Terrain file.  You will see a blue progress bar in the main 
Condor_tiles window.

When that is complete click on “Make Terrain (.TR3)” to generate the heightmaps files that Condor2 
uses for elevation. Depending on the size of the terrain, this may take a few minutes.  Again, the 
progress bar will appear in the main Condor_tiles window. The following files and folders were 
created within c:/Condor2/Landscape/hhsc1
  
hhsc1.trn 
HeightMaps/ – a folder containing series of files starting with h0000.tr3 – h1515.tr3

These contain the terrain data for each tile.  You should be asking if our terrain is 4x4, that 
should only be 16 files, why are there 256!!!?   Because…. Condor2 subdivides each of the larger tiles 
into 4x4 subtiles.  So 16 * 16 = 256.

How do you relate the numbers to the actual terrain location, check Appendix ONE for a 
complete explanation.  Real quick →  The bottom right tile is “0000”, the first two digits are the row, 
the second two are the column.  The tile to the left of the bottom right tile is “0001” and the tile above 
the bottom right is “0100”.  The tile in the upper right corner is “1515” (remember, total of 16 subtiles 
numbered 0-15).

NICE JOB! – you can close Condor_tiles for now.
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Step Four:  Condor Landscape Scenery Editor 

In our last step we’ll actually finish creating a flyable terrain.  It won’t have any real scenery, 
but you’ll be able to see 3-D terrain and fly it in Condor2.

1)  Start the Landscape Editor, and from the Landscape popdown in the upper right, you should 
see your new Landscape, hhsc1, as an option. You should see something like below. It doesn’t 
look like much, but it’s actually showing elevation features in the terrain.

How to maneuver.  As you move the mouse around, you are presented with a lot of useful 
location information in the bottom bar.  The latitude and longitude values should agree with 
what you’re expecting.   The Pos X,Y,Z numbers are in meters. By default, the editor puts you 
near the middle of the terrain.  To move around select the “FINGER” and you can drag the 
terrain.  Notice the yellow lines delimit the larger 4x4 tiles, and the dashed lines show the 4x4 
subtiles.

Click the left mouse button to zoom in, middle/right to zoom out. 

3)  A landscape must have at least one Airport defined to be flyable in Condor 2.  Using another 
tool like Google Earth you need to find the exact LAT/LON in decimal degrees for the middle 
of your runway, also the elevation (in meters).  Google Earth does give you the option of seeing 
decimal degrees and meters.
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For hhsc1 I used the name 4NY8:   42.119522 /  -76.900490  (THIS SHOULD BE THE 
MIDDLE/CENTER of the runway), elevation:  523 meters(1715’),  length: 500 meters (1640’), 
direction: 331 True (340-9W variation), width: 36 m. 

4) In the Landscape Editor, in the “View/Modify” box, check “Airports”.  Then put your mouse 
in the blank area beneath and click right.  A menu should appear, select ‘Add’.   Then fill in the 
values and select OK.   It should appear on the map.

4a) OPTIONAL – you may want to flatten the runway terrain.  Choose “Height Map” and the 
map will show you elevation, zoom into the runway, it should be outlined.  Then click on the 
“FLATTEN” icon and set the radius slightly wider than the runway, and set the altitude to 
elevation (in meters) and a slope ratio (1:3 is good). As you sweep your mouse you’ll see two 
concentric circles: the inner one is the flattening area and the ring between the inner and outer 
one is the graduated slope. It’s helpful to get the immediate runway area flat for placement of 
objects and ease of towing.

5) Now just complete the steps in the “Condor Landscape Guide”. Make sure to follow the 
order below:

a) File → Export flightplanner map
b) File → Export forest map.
c)  File → Export thermal map.

            d)  File → Export textures to DDS (As the guide says, you’ll need the Nvidia legacy 
texture tools placed in the same directory with the LandscapeEditor.exe for this to work.  Say 
‘No’ to export only nonexisting, we want everything recreated.
             e) File → Export terrain hash
             f) File → Export forest hash  (NOTE: These steps are important as an anti-cheat 
mechanism. ALSO, if you ever try to fly Condor2 and your elevator doesn’t work, make sure 
you have exported these recently).

g) File → Save Landscape

6) Leave the Landscape Editor open, until you perform the next steps.
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Step Five:  Take a test flight in Condor 

Just a little more to do. 

1) You still need two more files in the main landscape directory. Condor_Tiles will automatically 
create  two dummy files you can edit as needed.  You just need to start Condor_Tiles and then choose 
the ‘Read Header’ button on the upper right side.  You should then see some messages and the files 
will be created if they are absent:

UTM Zone:   18 N
UTM Bottom: 4618673
UTM Right:  387456
Height:     1024
Width:      1024
Resolution: 90
Delta X:    -90
Delta Y:    90

42 dummy centre tile airports \dhhsc1.apt created 

 hhsc1.ini –  Contains a version number, defaults to 1.0, this will also show to users in the Flight 
Planner when they selected the landscape e.g. Version=1.0

 hhsc1.cup –  This is another text file, which contains waypoint/turnpoint definitions. By default, 
a dummy waypoint is placed in the center of the scenery.  See the appendix for the format of 
this file.

 Back in the Landscape Editor, perform the final steps:

File → Export terrain hash
File → Export forest hash  (NOTE: These steps are important as an anti-cheat mechanism. 
ALSO, if you ever try to fly Condor2 and your elevator doesn’t work, make sure you have 
exported these recently).condor 3
File → Save Landscape

2)  Start Condor2 and select “FREE FLIGHT”.  In the upper right “Landscape” box you should now be 
able to select your scenery. NOTE: If you have only Condor 3, you will need to get the “Condor 
Updater” and run the conversion.

3)  TASK tab: You must define a simple task.  Click on “New” and then Click on your airport, move 
the mouse and it will create a line, Click again to create a turnpoint.  Just make a box, but end it by 
going to your airport and clicking again – you should get “Finish”

4)  NOTAM tab:  You can try an “Aerotow”, recommend change rope length to 200’.  We have not yet 
created a real airport, so the terrain and tow planes may not line up, doesn’t work? choose Airborne.

5) “SAVE” the flightplan and then click “Start flight”

NOTE:  When the flight starts, check your flight controls.  If you cannot move the stick forward/aft 
please re-export the terrain and forest hash shown earlier in the landscape editor, then save again.  
The lack of stick control is a security feature against ‘tampered’ sceneries….
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Part Two:  Photo Scenery creation

Step Zero:  Download extra needed tool.

There is probably a way to do this for FREE and we’re happy to update the tutorial.  For now you’ll 
need to spend a little money for a tools that makes downloading satellite imagery easier.

Go to http://AllMapSoft.com/ and download the “Google Satellite Maps Downloader.”  To create HI-
RES scenery as we will in this case, you’ll need the paid version. 
Your version should be at least 8.368

Let it install to the default location, usually: C:\allmapsoft\gsmd

After it installs you’ll need to create a symbolic link to make it usable by other tools.  To do that you 
need to run a Command Prompt window as the Administrator. 
NOTE:  Use “Command Prompt” and not “Power Shell”.  Then give these commands:

C:\WINDOWS\system32>cd \allmapsoft

C:\allmapsoft> dir

 Directory of C:\allmapsoft

05/11/2020  01:31 PM    <DIR>          .
05/11/2020  01:31 PM    <DIR>          ..
05/11/2020  01:22 PM    <DIR>          gsmd

C:\allmapsoft> mklink /D gmid gsmd
symbolic link created for gmid <<===>> gsmd

Confirm with a ‘dir’ command. Depending on your version of Windows, you’ll see something that 
matches the below

C:\allmapsoft> dir

05/11/2020  01:32 PM    <DIR>          .
05/11/2020  01:32 PM    <DIR>          ..
05/11/2020  01:32 PM    <SYMLINKD>     gmid [gsmd]
05/11/2020  01:22 PM    <DIR>          gsmd

C:\allmapsoft>dir
 
03/31/2023  11:36 AM    <DIR>          .
03/31/2023  11:36 AM               847 gmid.lnk
04/03/2023  04:37 PM    <DIR>          gsmd
               1 File(s)            847 bytes
  

For Condor scenery generation, the concept is to get a set of these imagery tiles at a desired resolution 
for a given area to fit into Condor tiles of a desired resolution.   Review   APPENDIX ONE – General 
notes on Scenery Creation for more info and a table of zoom/resolution in meters.
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Step One: Create the commands necessary to download images

1) Start  Condor_Tiles  (IMPORTANT: click right and choose "Run as Administrator") To minimize 
the download data size, Condor_Tiles creates ‘symbolic-links’ for the imagery folders and needs 
administrator level for this step. 

     Pick the landscape name and Version should stay at V2 (this is for Condor2, not version 2 of your 
scenery.  NOTE: Don't worry, the landscape will still work for Condor 3!
     Pick the type of data imagery (we'll be using Tiles).
     Pick the desired Tile zoom level (we'll use 16 for high resolution)
     Pick the desired tile size for Condor, which should match closely to the zoom level (8192)

NOTE: High resolution uses of lot of disk space. Use zoom level 15 for large Landscapes, with a tile 
size of 4096.

 2) Click on 'Read Header' button to load the UTM data of the scenery extents

You should see something like this in the message area:

Reading Terrain header...
UTM Zone:   18 N
UTM Bottom: 4618673
UTM Right:  387456
Height:     1024
Width:      1024
Resolution: 90
Delta X:    -90
Delta Y:    90

  3) Click on the 'Make GMID' button to generate initial coordinate extent files for each tile.  These 
files will be used by the Maps Downloader.  Again, you can see the numbering coordinate system used 
for the files.  These are text files.  You will find them in the ./Working/SourceTiles
  

Step Two:  Download the image data.

NOTE: The latest version of  GoogleSatelliteMapsDownloader and Condor_Tiles allows us to 
automate much of this process.  To see details on the manual method, reference Appendix Two.  

1) Condor_tiles has created a couple of batch files to automate the process in the :
GM c:\Condor2\Landscapes\hhsc1\Working\SourceTiles folder:

-rwxrwxr-x jmurtari   None  1250 May 11 11:56 ./Working/SourceTiles/GMID_ALL.bat
-rwxrwxr-x jmurtari   None  690 May 11 11:56  ./Working/SourceTiles/GMID_ALL_Combine.bat

Again, in a Command Prompt window, change to the tiles directory and run GMID_ALL:

> cd \Condor2\Landscapes\hhsc1\Working\SourceTiles
> GMID_ALL

Note that some of the batch files call other batch files, so you may not run all the batch files listed.
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This takes about 30 minutes on a 4x4, 16 tile scenery.  You will see new windows open and close  for 
downloading and combining files as it works it’s way thru the process, e.g.

  

NOTE:  If the scenery has more than 55 tiles, it is possible the process will be interrupted as Google 
sets limits for downloads.  In that case you will have to wait 24 hours to resume.  You can just give the 
GMID_ALL command again, the tools will skip images that have already been downloaded.

2) At the end of the automatic process, you've created 16 .bmp files, one for each tile:
/cygdrive/c/Condor2/Landscapes/hhsc1>find ./Working/SourceTiles -name "*.bmp" -print

./Working/SourceTiles/0000/0000_combined/0000.bmp

./Working/SourceTiles/0001/0001_combined/0001.bmp

./Working/SourceTiles/0002/0002_combined/0002.bmp

./Working/SourceTiles/0003/0003_combined/0003.bmp

./Working/SourceTiles/0100/0100_combined/0100.bmp

./Working/SourceTiles/0101/0101_combined/0101.bmp

./Working/SourceTiles/0102/0102_combined/0102.bmp

./Working/SourceTiles/0103/0103_combined/0103.bmp

./Working/SourceTiles/0200/0200_combined/0200.bmp

./Working/SourceTiles/0201/0201_combined/0201.bmp

./Working/SourceTiles/0202/0202_combined/0202.bmp

./Working/SourceTiles/0203/0203_combined/0203.bmp

./Working/SourceTiles/0300/0300_combined/0300.bmp

./Working/SourceTiles/0301/0301_combined/0301.bmp

./Working/SourceTiles/0302/0302_combined/0302.bmp

./Working/SourceTiles/0303/0303_combined/0303.bmp
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Step Three:  Convert images to Condor tiles

Now each image is converted into a Condor tile, by 'warping' to UTM and 'cropping' to the desired size.

NOTE:  If you took a break in the process and just re-started Condor_tiles, make sure to select the 
proper landscape and click on the “Read Header” box.

This process is automated below, for information on the manual process see Appendix Two.  Also, note 
that these batch files sometimes create messages such as “Cannot find file xxxx.xxx” or assorted Error 
messages. Not all of these messages are indicating failure of the programs. It’s best to run each step to 
completion and then check to see if the indicated output has occurred before deciding there is an 
execution error.

With Condor_Tiles, click on “Make GDAL”
 but do not select a tile, i.e. leave the tile selector blank. Condor_tiles creates a batch file 
‘GDAL_xxxx_TIF.bat’ in each tile folder 
..\Working\SourceTiles\xxxx and an overall batch file ‘GDAL_ALL.bat’ in the
..\Working\SourceTiles folder. 

Again, in a Command Prompt window, run  GDAL_ALL  to start the process.  For a scenery with a total 
of 16 tiles (4x4), it can take about 15 minutes.

When you're done, again 16 files created in a new directory, these will be large files, >200 Meg each.

jmurtari@anvil:/cygdrive/c/condor2/Landscapes/hhsc1>
./Working/Terragen/Textures/0000.bmp
./Working/Terragen/Textures/0001.bmp
./Working/Terragen/Textures/0002.bmp
./Working/Terragen/Textures/0003.bmp
./Working/Terragen/Textures/0100.bmp
./Working/Terragen/Textures/0101.bmpGo_s
./Working/Terragen/Textures/0102.bmp
./Working/Terragen/Textures/0103.bmp
./Working/Terragen/Textures/0200.bmp
./Working/Terragen/Textures/0201.bmp
./Working/Terragen/Textures/0202.bmp
./Working/Terragen/Textures/0203.bmp
./Working/Terragen/Textures/0300.bmp
./Working/Terragen/Textures/0301.bmp
./Working/Terragen/Textures/0302.bmp
./Working/Terragen/Textures/0303.bmp 
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Step Four:  Create the final scenery

1) Run the Landscape editor, and pick the landscape, and then in Tools, 'Import tile sized textures'
   - the images in Working/Terragen/Textures will be loaded as the imagery.
   - this will replace the initial black-and-white terrain based imagery.

2)  You can check your airport placement with the imagery, and carefully adjust the lat/lon for the 
proper position. 

3) In the Landscape editor the run the same export commands as before. 

            a) File → Export flightplanner map
b) File → Export forest map 
c)  File → Export thermal map 

            d)  File → Export textures to DDS (As the guide says, you’ll need the Nvidia legacy 
texture tools placed in the same directory with the LandscapeEditor.exe for this to work.  Say 
‘No’ to export only nonexisting, we want everything recreated. This will take about 40 minutes 
for a 16 tile scenery.

NOTE:  When this is done you can also use Condor_tiles to tune the runway position.  Start the 
program, pick the landscape, click on 'Read Header' and then 'Airport Place'.  A separate 
window will appear that allows you to make fine position adjustment using the arrow keys.   
You will see a blue line also, that is the tow plane track.   Make sure to save your changes!
             e) File → Export terrain hash
             f) File → Export forest hash  (These steps are important as an anti-cheat mechanism. 
ALSO, if you ever try to fly Condor2 and your elevator doesn’t work, make sure you have 
exported these recently).

g) File → Save Landscape

 

Step Five: Splash Screen and Imagery Credits

When Condor loads you see some large images displayed as the scenery is being loaded,  in the default 
Slovenia 2 landscape,  ‘Two burly guys in a glider!’

It’s easy to create your own.   We’d recommend at least 1920x1080 in size (HDTV/16:9 ratio) and JPG 
format.  Your landscape has an Images subfolder.  It will be empty, but you can copy the files and they 
are used in random order.  As you see below, just use a number as the name, starting at 0 (zero).

 Directory of C:\Condor2\Landscapes\hhsc1\Images

05/12/2020  08:12 AM         1,714,475 0.jpg
05/12/2020  08:12 AM         1,528,563 1.jpg
05/12/2020  08:12 AM         2,053,719 2.jpg 
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See APPENDIX THREE about imagery usage.   Not real practical to put tags in the landscape that 
will never be seen.  We’d suggest adding some text somewhere on your Splash Screens to credit 
Google.   ALSO, don’t forget to give us a LITTLE LOVE!  We’d be happy if you’d share the source of 
help, e.g.

Satellite imagery: Google Earth
Help from: SoaringTools.Org 

CONGRATULATIONS – you should have a flyable landscape!  If you'd like to share it, let us know 
and we'd be happy to  offer a download from our site.

Now you just need to create a nice airport/runways and potentially user higher resolution in the 
immediate airport area.  See the        OPTIONAL EXTRA PROCESSING section that foll

You can find some excellent tutorials on using the other Landscape utilities and how to  create a 
detailed airport with buildings in their "Downloads" area ->  
https://www.condorsoaring.com/downloads-2/

Be prepared for some reading, the English version of the Airport Creation tutorial has over 130 pages!
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       OPTIONAL EXTRA PROCESSING
           None of these items are required, but they can enhance your scenery.  We especially recommend 
adding a smooth runway and also using a higher tile resolution in the immediate airport area.

cat Higher resolution scenery for airport area tiles (¼ tiles)

    From: Nick Bonniere 
For this procedure we assume you have already completed the entire landscape and imagery is present 
following the earlier steps in this tutorial.   At this point we may want to use higher resolution in the 
immediate airport area.

NOTE: You may wonder why we limit ourselves to ¼ of a full tile when going to higher resolution.  
The additional imagery detail has quite a cost in disk space:

 Zoom level 16, tile size: 8092 (our default)– resolution of 2.8 meters/pixel, file size: 2.8 Meg
 Zoom level 18, tile size: 32768 – resolution of .7 meters/pixel, file size: 44 Meg
 Zoom level 19, tile size: 65536 – resolution of .35 meters/pixel, file size: 178 Meg

The quarter-tile number is used instead of the tile number, because the tiles are further sub-divided into 
4x4, Tile 0202, becomes 16 tiles, 0808, 0809, 0810, 0810, 0811 … 1111 and you have to pick the right 
one(s). You can use the Landscape Editor. The Patch X/Y values are at the bottom of the screen, e.g. 
PatchX: 8, PatchY:11 is converted to quarter tile 0811.

1. Start condor_tiles (run as admin), select the landscape, read the header.

2. In the selection boxes manually type 65536  in the “Tile Size” box.  Manually type 19 in the 
“Tile Zoom.”  Make sure GeoData is set to “OSM”.

3. Click on the “Utilities” button.

4. Next to the “Quarter Tile KML GDAL DDS” button, enter one quarter tile number (0811) and 
then press that same button.  You’ll see a message about created files, the names will have a 
reference to the full tile position, e.g. 0202 in our case.
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5. Go to the folder Working\SourceTile\0202\QuarterTiles

6. Make sure Texture Compressor Path is correct, you should use Compressonator.

7. In the QuarterTiles folder, in a command prompt window, run the MAKE_ALL_xxx.bat file 
(the one without the _4326). It will take care of downloading the tiles, combining them, and 
producing the final .dds texture files with the increased resolutions

8. It does download a lot, it may be disconnected early.   You should run it again to double-check. 
It will only download anything missed.  No harm in the process.

9. The new file will be in the same directory, e.g. t0811.dds (app. 178 megabytes in size).

10. You will need to copy that file to the <landscape>\Textures folder, it will replace the existing 
t0811.dds (2.7 megabytes in size). 
NOTE: Before doing this copy, make a backup version of the files you’ll be replacing.  The 
original resolution version are necessary if you wish to create a forest map later.

11. You’re ready to fly the landscape!

NOTE:  When running the ‘downloader’ in step 7 above, it may terminate with an error about 
licensing, just start it again and it will pickup where it left off.
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How to create a transparent runway surface.

For airports using concrete/asphalt pavement, the easiest method to get a realistic runway is to use high 
resolution in the just the airport area (as describe previously), and then create a transparent surface to 
deliver a smooth takeoff. 

Overview: A condor airport consists of a ‘G’ file and an ‘O’ file.  Another runway is another airport. 
The G file is runways, natively condor understands only grass and asphalt.  The glider sits on top 
smoothly.  The O file contains objects like windsocks, buildings, or other objects. Contact with one of 
those breaks the glider.  The windsock is special since condor changes the orientation depending on 
winds you select.  The pole is stationary, the windsock sits on stop, as two separate objects.

The steps are as follows, using an example landscape called: ‘cap-ner’

1. Create the folder cap-ner\Working\Objects – this will hold some temporary files used to create 
the objects.

2. Create the folder cap-ner\Airports\Textures – this will hold 3 d objects.

3. In the folder where you installed Condor_tiles you will see a folder named “Simple 
Objects\Textures.”   You should copy two of those files,  Mast.dds and Transparent.dds, to the 
cap-ner\Airports\Textures folder you created above.

4. Start condor_tiles, select the landscape, and click on “Read Header.”  The select “Simple 
Objects.”

5. When the Simple Object window appears, make sure the “Simple Objects” tab is selected, and 
in the “Type” pull down menu select 
Asphalt, fill in the other boxes as shown 
(with the correct runway length/width).

6. Select “Save As” and use a meaningful name. The file will be stored in the Working\Objects 
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folder you created.  Two files will be created with a .so and .c3d extension.  The files will have 
different contents. 

It is recommended you use the runway name to avoid confusion if the scenery could contain 
more that one airport/runway. Make sure you add the ‘.so’ extension to the name.

7. Next we will create the windsock and its pole. 
Return to “Simple Objects” and choose “New” 
and then “Pole.” Then select the correct width 
and height (in meters).  The File Name and Path 
should fill in automatically.  Make sure you save.

8. Then choose “New” and “Windsock” (you are allowed up to three for one airport).  You can set 
the length as desired, but the height must match what you 
selected for the pole.  They are actually two separate 
objects within Condor.

9.  Again, repeat the “Save As” operation and start the name 
with the word “windsock.”
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At this point you’ve created all the basic objects, you should have directory contents similar to the 
below:

c:\Condor2\Landscapes\cap-ner\Working\Objects>dir

02/18/2024  02:45 PM               256 Grass-KSVF-05.c3d
02/18/2024  02:38 PM                52 Grass-KSVF-05.so
02/18/2024  02:49 PM               510 pole-KSVF-05.c3d
02/18/2024  02:49 PM                45 pole-KSVF-05.so
02/18/2024  02:55 PM               190 windsock-KSVF-05.c3d
02/18/2024  02:55 PM                32 windsock-KSVF-05.so

10.  We are now ready to position our windsock in the airport area, but we must first get the exact 
position.   Again, we’ll use “Airport Place” to get a view of the field.  Before you select the 
airport make sure you choose “Terragen” in the Options area.

11. As you move the mouse over the images, you’ll see two numbers changing in the lower left 
corner.  When you reach the position desired, write down the values.  In this example:
176 “Easting” and -685 “Northing”.    The are the meter distances from the airport center as you 
defined in the landscape editor.
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12. We are now ready to group these to make a Composite Object.   Select the “Composite Object” 
tab and press “Add”.   It will add a placeholder object with xxx as a name

13. Double click in the File box and 
you will be able to choose another 
object you created.   We’ll be 
picking the pole and the windsock.

14. We must now position each object 
using the “Easting” and “Northing” values (units of meters), we recorded earlier.  The image 
shows the complete entries.

15. As before, we’ll use “Save As”.   The file name is very important, it will be the name of the 
airport with the letter “O” added.  KSVF-05O.co 

16.  The next is to create the runway surface, the ‘G’ file.  Delete the existing two lines in the 
composite object window, press Add, and add the file name “Grass” which actual is transparent.

You do not make any 
entry in the 
Easting/Northing values. 
That is already the center 
of the runway.

17. As before, we’ll use “Save As”.   The file name is very important, it will be the name of the 
airport with the letter “G” added,  use KSVF-05G.co

18. NOTE: Condor 3 – after create you create the runway G file.  You must edit  the runway G file, 
e.g. KSVF-05G.c3d with the Condor Landscape Object Editor.   You will normally see a single 
entry with these values:

Change ONLY the “Alpha” value from 1.00 to 0.00 and save again “Save to C3D”, using the 
same file name. This does not effect Condor 2, but will ensure the runway displays properly in 
Condor 3.
Also – for some reason on the 1st save, it may not store the new value. After you make the 
change in the “Alpha” column, move the mouse to one of the other columns and just click to 
select (but don’t change the value) and save.   To confirm, close and restart the Object Editor, 
reopen the file and confirm.

19. The final step is to copy the “O” and “G” files to your Airports folder.
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How to create a building/hangar for your airport.

Having structures near the runway can be helpful in creating a realistic environment for takeoffs and 
landings; however, they can be difficult to create for ‘non-graphics wizards’ – which is most of us!

Condor_tiles supports the creation and positioning of simple structures.  Its repertoire of structures is 
limited, but will hopefully grow in the future.  In the following we take you through the steps used to 
create a structure near Runway 18 at the Oskosh Airport (KOSH). 

Background on how Condor handles “objects”

We’ll provide step-by-step instructions, but to feel comfortable, it helps to understand some basic 
concepts on the various files involved.  Here is a some of what you’ll encounter and a simple 
explanation of each.  You can also reference       APPENDIX SEVEN: Notes on object 
creation/placement which has additional info.

We start from the top folder in your landscape:

Airports/ - When you first create a simple airport(runway) and give it a position/size, this folder is 
empty.  Condor starts your aircraft at an offset from the runway end and heading into the wind.  Even if 
you’ve flattened the terrain, it can be a bumpy takeoff.
Once you create a runway surface and windsock in our tutorial, you’ll see the following:

Airports/KOSHG.c3d – This has the name of the airport followed by the letter “G” for Ground 
objects.  This is normally just the runway surface.  Condor puts you on top of the smooth surface.  
Ground objects can’t hurt the glider.   This file is not viewable as text and contains references to .dds 
files located in the “Textures” subfolder.  These are created with other tools, but can be viewed with an 
image editor.

Airports/KOSHO.c3d -  The letter “O” is for surface Objects, a windsock, hangars, etc...  Hit these 
and the wings come off!  This contains the contents of other .c3d files which contain the detail of 
individuals structures.  It has their location info as offsets from the lat/lon you previously defined as the 
airport location.   Change the airport lat/lon and all the objects move with it.

This file is not viewable as text. It contains geometric point positions, a wire frame, that describes each 
object.  Not very pretty to look at.  It has references to the files which contain the “Texture” used to 
wrap the frame.  Those files are usually in a subfolder called “Textures.” The texture is an image 
in .bmp format.  Think of it as specially patterned wrapping paper.  You can view/change the texture in 
any image editor.

NOTE:  Condor requires both the “G” and “O” files to exist!  You might think all I want is the runway 
and I don’t need an “O” file.  It is required, just add any tiny object and Condor is happy.
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Airports/Textures/Transparent.dds – As ‘built ins’ Condor understands two types of runway 
surfaces, Asphalt and Grass, and it knows how to show an image.  The default can usually work for 
grass, it’s just green, but rarely works for a real runway since there are no markings.  Condor does 
support a user defined texture, and in our tutorial we use transparent.  This allows the original surface 
to be displayed.

Airports/Textures/H_PK_Blue.bmp – This is an example of an image file that contains what is 
visible for a surface object like a hangar.  Again, you can give the file in an image editor.  You’ll notice 
the file has a grid pattern which covers each surface of the hangar, front, sides, back, and top.

This can be created from actual photographs using different perspectives, or more slowly with an image 
editor like GIMP of Photoshop.  You can also take an existing image and change the colors.

Step by Step Instructions

1. The first step is getting accurate size 
information.  You can try either Bing 
or Google to get the best satellite 
imagery (they use different sources).

2. Using Condor_tiles → Airport Place: 
We’ll make the simple structure 
identified by the circle.
NOTE:  If you’ve created a hi-
resolution tile for the airport area, 
when running “Airport Place” select 
the “Terragen” radio button in the 
“Options” section.

3. A very import item in Condor_tile (Airport Place) is the position info it supplies in the lower 
left part of the main window.  As you move the 
mouse, you’ll note those numbers are changing.

The units used are “meters”, as are most units 
in object creation.  The values are “Easting, 
Northing” as used by cartographers.  The zero 
point is the position of the runway center. 
Marked in Airport Place by a red cross.

For example, in the diagram to the right. If I 
position the mouse over the circled orange dot, 
I see the values are -1.02 (Easting), -232.08 
(Northing).  I’m very close to runway 
centerline, but I’m a couple of hundred meters north of the center point.
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4. We use Condor_tiles to zoom in on the structure.  We can get it’s center position coordinates, 
and by pointing the mouse at the corners and noting the change in meters, you can determine 
the size.  In our case we get the following:
Center: -286.8 / -879.3 m,  width: 37.5 m, length: 53.3 m

But what about the height, roof type – 
you can use Google or Bing street 
view to get some perspective. 

It’s a peaked roof, white building, 
people about 6’ high, top of roof, 
maybe 12’ (4 m), peak size of 6’ (2 
m).

We’re now ready to create the 
structure!

5. Start condor_tiles, read header, and go “Simple Objects”

6. You can then pick a Type:  Flat_roof, Peak_roof, 
Dome (Quonset hut) – we’ll choose Peak_roof.
NOTE: The names correspond to file where 
Condor_tiles was installed, 
SimpleObjects/textures

7. Pick your dimensions (in meters)

8. Pick “Save As”, give it a good name, e.g. 
hangar1.so and place in your 
<landscape_name>/Working/Objects folder.
NOTE: You may need to create the folder if it 
doesn’t exist.

9. Next, we will choose the “Composite Object” 
tab to create what will become the KOSHO.c3d
It allows us to add each structure to the airport area and define its exact location and orientation.
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10. To position it, select “Composite Object” / “Open” – and pick your Airport File Object file “O 
file”, e.g. KOSHO.co, you should see the pole and windsock, now we choose the “Add” button 
and select the structure.  Set the position.

NOTE:  Once you create a structure, you can use it multiple times in different positions.

11. Do a “Save As” to the airport “O” file name you used before.

12. You need to copy the .c3d files to your “Airports” folder.

13. Any textures you used in Step #2 above, need to be copied from the SimpleObjects/textures 
folder to your landscape Airport/Textures

14. As a check, you can start Condor_tiles, read the header, choose “Airport Place” again and make 
sure that “Terragen” is selected in “Options”.  Then you can select “O File” to see your 
structure using a black outline.

15. Fly condor.

16. If the structure is not facing the correct direction, you can set the rotation angle also in the 
Composite Objects, the rotation is clockwise.

NOTE: The next section shows you a method to change the surface appearance of your structure.
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ADVANCED STRUCTURE MANIPULATION

Let’s now assume we don’t like the color of our hangar, we’d like it to be a white exterior.

Currently, from the cockpit, this is what we see (on the left).  On the right is the texture file that 
supplies the imagery used (SimpleObjects/H_PK_blue.bmp).  The imagery is a simple Window Bit 
Map file and can be edited with many tools

We’ll edit this file with GIMP (being sure to save it with an 
alternate name):  H_PK_white.bmp

We create a new object, same size, but with a different file name 
for the texture.

We add the object at a slightly different position, below is the 
cockpit view and the .bmp file used.
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Creating custom thermal maps & forest maps

You can create custom thermal/forest maps for Condor.  It can be a lot of work.  Condor_Tiles has 
some support for using publicly available data to automate the process.  Below are some background 
notes and then an example.   Background By Nick Bonniere

For thermal and tree maps, it can be done by hand, basically ‘painting’ forests, roads, fields, etc.. onto a 
background of each tile. This takes way too long, but will match the textures very closely.  For a 
landscape in Canada, the Geogratis website can be used, but it only covers the Canadian landmass.

Creating a Forest Map for your entire landscape

In this example we’ll be creating a map for a Harris Hill landscape.  Will be using free public data 
collected by the University of Maryland.

We’ll start Condor_tiles as usual and make a few changes in the top settings:

 For GeoData (upper right), choose 
Global Land Cover (GLC).

 Click on “Read Header”

 Set the tile size to “2048”, the GeoData 
is at a lower resolution than imagery.

 You can ignore the “Tile Zoom” 
setting, it is not used for this operation.

 Then press “Make GEO” and you will 
see output similar to what’s shown.

   Some batch files have been created in  
Working\GeoDatabase:

GLC_WGET.bat  GO_b.bat  GO_f.bat  
GO_s.bat  GO_t.bat  GO_w.bat

In a command prompt window, you’ll first run the GLC_WGET to retrieve the raw data, then run:

Go_b (deciduous trees), Go_s (connifer trees), and Go_t (terrain data used for thermal map)

The last steps are easy:

 In the Landscape Editor, load the landscape and then choose Tools → “Import tile size forest 
maps”

 NOTE:  If you previously created a hi-res quarter or full tile, you must temporarily restore the 
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original tiles (.dds) before performing the next step.  After the export is complete, you can 
restore the hi-res versions.

 Make sure you redo all the save steps for a landscape, including export forest maps.

Creating a Thermal Map for your Landscape

By default, Condor creates an ‘equal’ thermal map for your landscape.  There are no good or bad 
regions.   The step above in loading forest Geo data also has a step to collect ground characteristics for 
thermal maps, e.g.  is it a forest, farm land, barren, desert, city, water.

Assuming you’ve done the earlier forest map steps.  Start Condor_tiles, leave the GeoData at GLC and 
the Tile Size at 2048.   Read the landscape header.

 In Windows, create a folder called 
“Thermalmap” in your landscape 
“Working” directory.

 Choose “Make Thermal”, accept the 
default for heat settings and check all three 
boxes as you see on the left.

 The press “Proceed”

 Your new thermal map is in your top 
landscape folder, it is called 
<landscape>.tdm

 Exit from Condor_tiles or you may see an 
access violation error later in the Landscape Editor.

 You can then start the Landscape Editor, load the landscape, and click on “Thermalmap” to see 
a grey scale version.  The lighter the color, the strong the thermal area.  Water will be black.

 Make sure you redo all the save steps for a landscape, including export thermal map.
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  APPENDIX ONE – General notes on Scenery Creation
by Nick Bonniere

1) A scenery is a made up of a group of tiles

2) Each tile is 23 km x 23 km (14.29 mi x 14.29 mi), which is actually a resolution 
of 90 meters times 256 = 23.040 km
  
If you pick 4 tiles, I would suggest you offset the airport from the center a bit 
so it falls fully into one of the 4 tiles, otherwise it will be cut-up into 4 
pieces. Not absolutely necessary, just a suggestion so you can view the airport in 
one tile only.

3) The original resolution of 90 m is based on Space Shuttle elevation data (STRM)

4) Condor 2 uses a resolution of 30 meters, which is 3 times the resolution of 
Condor 1, and 30m STRM data is available

5) The last 1/4 tile edge of a scenery is not flyable. So if you have one tile, 
only the centre 1/2 or 11.5 km x 11.5 km is flyable, If you use 2 x 2 tiles, i.e 4 
tiles, 46 km x 46 km, only the centre 34 km x 34 km is flyable, etc...

6) The projection used is UTM, (Universal Transverse Mercator), This means that all 
elevation data and photographic data needs to be converted to UTM coordinates. 

7) Tiles are in a grid of rows and columns starting at the bottom right corner 
(South East), which is tile 0000. The first two digits are the column number and 
the second two digits are the row number. Above tile 0000.bmp is tile 0001.bmp. The 
tile to the left is tile 0100.bmp
8) You can use multiple resolutions. For LakePlacid, the centre tile is hi-res 
8192x8192, while all the other tiles are 4096x4096.  The file size increases by a 
factor of 4, 48MB file (at 4096) instead of 192MB (at 8192).
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9) Notes on Tile system zoom level and Condor resolution

You have to match the zoom level with the tile-size. I have not gone beyond zoom 
18. The imagery is 'warped' when projected to UTM coordinates, so I use a zoom 
level that provides just above resolution than needed. For example, for a Condor 
resolution of 16384 (1.4m), a zoom level of 17 (1.2-0.85m) is good. 

 I do 4096 for general tiles and 16384 around airports. Sometimes I do Quarter-
Tiles around airports at 32768, not full 4x4 tiles. With Condor, It is OK to do 
various tiles are different sizes. Area over forest do not need high-resolution, 
but for areas around airports when you fly at a low altitudes, a higher resolution 
is good.

  
- Tile system zoom level  (approximately)
- zoom level 1 - each pixel is 78184 m (equator), 55284 m (45 deg latitude)
- zoom level 2 - each pixel is 39092 m (equator), 27642 m (45 deg latitude)
.....
- zoom level 10 - each pixel is 152.7 m (equator), 108.0 m (45 deg latitude)
- zoom level 11 - each pixel is  76.3 m (equator),  54.0 m (45 deg latitude)
- zoom level 12 - each pixel is  38.1 m (equator),  27.0 m (45 deg latitude)
- zoom level 13 - each pixel is  19.1 m (equator),  13.5 m (45 deg latitude)
- zoom level 14 - each pixel is   9.5 m (equator),   6.7 m (45 deg latitude)
- zoom level 15 - each pixel is   4.8 m (equator),   3.4 m (45 deg latitude)
- zoom level 16 - each pixel is   2.4 m (equator),   1.7 m (45 deg latitude)
- zoom level 17 - each pixel is   1.2 m (equator),   0.85 m (45 deg latitude)
- zoom level 18 - each pixel is   0.6 m (equator),   0.43 m (45 deg latitude)
- zoom level 19 - each pixel is   0.3 m (equator),   0.22 m (45 deg latitude)

- Condor resolution
- tile size  256 - 23040 m, each pixel is 23040/256  = 90 m
- tile size  512 - 23040 m, each pixel is 23040/512  = 45 m
- tile size 1024 - 23040 m, each pixel is 23040/1024 = 22.5 m
- tile size 2048 - 23040 m, each pixel is 23040/2048 = 11.25 m
- tile size 4096 - 23040 m, each pixel is 23040/4966 = 5.625 m
- tile size 8192 - 23040 m, each pixel is 23040/8192 = 2.8125 m
- tile size 16384 - 23040 m, each pixel is 23040/16384 = 1.4 m
- tile size 32768 - 23040 m, each pixel is 23040/32768 = 0.7 m
- tile size 65536 - 23040 m, each pixel is 23040/65536 = 0.35 m 
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      APPENDIX TWO – manual run of downloader/combiner

In Part Two of this document (Photo Scenery Creation), Steps Two and Three cover the downloading 
of image data and how it is combined into tiles usable for Condor.  This is now an automated process, 
but below is more detail to cover the old manual method.

 Downloading images manually

1) Run the GoogleSatelliteMapsDownloader downloader.exe. 

a) Click on "Open Task" and select the Initial_0000.gmid file.  Make sure "Zoom level" is set to 
16 (or whatever was selected earlier) and "Maps type" is Tiles.

b) After it opens change the "Task name;" box to keep the original since the file will be 
overwritten:

Initial_0000.gmid  to  0000.gmid  (YOU ARE NOT changing the actual file name, just the Task 
name.)
  
 c)  You should see LAT/LON values fill in (taken from the file), and they should make sense 
with your scenery location.

  
  d) Click on "Start" to begin  the download process.
 You should see a "Downloaded" count in the lower left, it should eventually reach the "Total 
images" number.   If it seems to get stuck, or no progress, make sure you can reach the google site.

             e)   What's actually happening:

  - a folder 0000 will be created and a set files will be downloaded into that folde
  - these files are 256x256 images that cover the desired area, but actually cover more area than 
needed
  - at the end, the file 0000.gmid will contain the actual coordinate extent of the downloaded 
tiles 

 f) REPEAT the above steps for all 16 tiles – don't make any typos! Yes, this is a bit time 
consuming.  We're trying to convince them to create a command line version of the tool that 
could be used as part of a larger script.

2)  Still in the downloader.  Select "Tools -> Map Combiner", that will take care of merging all the 
individual 256x256 files. 

a) Select the "0000.gmid" file (NOT the one prefixed with "Initial_") and untick all image types 
except bitmap.   For Automatic generation of Condor Tiles, also select TIFF image type.

b) REPEAT for all 16 tiles. 
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 Combining images

    1) Start Condor_tiles. To create the batch file that will do this, on Condor_tiles, pick the desired tile 
in the "Tile" section,  0000 in this case, and click Make GDAL

  - a batch file ./Working/SourceTiles/000/GDAL_0000.bat will be created.
  - double-click on the batch file and it will process the data
  - a new image 0000.bmp will be placed into the Working/Terragen/Textures folder

  
REPEAT for each tile, 0001, 0002, etc... 

 You can do these simultaneously if your PC has the memory.  Each is independent.

ALTERNATE:  If you have a unix shell available, a command similar to the below will process all.

jmurtari@anvil:/cygdrive/c/condor2/Landscapes/hhsc1/Working/SourceTiles> for dir in `ls -d 
0*`; do echo "#### Processing $dir"; cd 
/cygdrive/c/condor2/Landscapes/hhsc1/Working/SourceTiles/$dir; ./GDAL_$dir.bat; done

#### Processing 0000
…..
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 APPENDIX THREE – Licensing, Google and Satellite Imagery
This tutorial uses imagery data collected by various satellite sources and compiled by Google and made 
available for download.  We’re happy to acknowledge the great help that is.  Licensing can always be 
an issue (see link below for more info and references).

We certainly feel we are making ‘FAIR USE’ of their imagery and transforming it into a new product.  
That all being said we strongly advise NO COMMERCIAL use, e.g. You shouldn’t setup a website 
where people give you coordinates and you spit out a scenery they can download for a fee.  It might be 
OK, but it might not under FAIR USE. 

More on FAIR USE →     https://FreeGeographyTools.com/2007/fair-use-and-google-earth-imagery  

You can certainly acknowledge Google. We’d suggest adding some text somewhere on your Splash 
Screens, some have used: “Satellite Imagery – Google Maps”
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    APPENDIX FOUR –  Distortion: Flat map over round earth

Some of you interested in enigmas and brain-teasers may be asking, “How can satellite photos of a 
ROUND Earth be flattened?”   Well just think back to older flat maps you’ve seen… mercator 
projections, etc…. 

by Nick Bonniere

     When you fly in real-life, you are flying over a sphere. When you fly in Condor, you are flying over 
flat terrain which is a projection of a sphere onto a flat surface. For Condor this projection is UTM 
(Universal Transverse Mercator). Just like for any flat map such as a paper map, the projection results 
in distortion. The further away from the centre point of the projection, the more the distortion and that 
is why you need to pick the closest UTM zone.

When images are downloaded, they have already been flattened based on a tile projection system. For 
use with Condor, they have to be re-projected to UTM. This is where epsg:3857 and espg:4326 come 
in. They refer to the projections and coordinates.  If you use the right one, you minimize distortions, but 
if you use the wrong one, you introduce more distortion. Over small distances, the distortion is small 
and in a Condor tile (23040 metres wide), the difference between epsg:3857 and espg:4326 is about 10 
to 15 metres.

For your 5x5 scenery, you can determine the overall effect of the UTM projection. You take the lat-
long coordinates of opposite corners and do a great-circle calculation, and for condor you do an 
arithmetic distance calculation. 

For 5x5, Condor opposite corner distance is (2*(5x23040)^2)^0.5 =  162.92 Km

Great-circle calculations for one diagonal is: 162.85 km, the other diago

nal is: 162.84 km

As you fly in Condor, you are totally un-aware of any distortion. Reaching a turn-point is simply a few 
more metres away than in real-life, and for a 5x5 about 250 feet over 100 mi.
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 APPENDIX FIVE –   GNU Free Documentation License
Reference:      https://www.gnu.org/licenses/fdl-1.3.en.html

Version 1.3, 3 November 2008

Copyright © 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc. <https://fsf.org/> 

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it 
is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document 
"free" in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with 
or without modifying it, either commercially or noncommercially. Secondarily, this License preserves 
for the author and publisher a way to get credit for their work, while not being considered responsible 
for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must 
themselves be free in the same sense. It complements the GNU General Public License, which is a 
copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software 
needs free documentation: a free program should come with manuals providing the same freedoms that 
the software does. But this License is not limited to software manuals; it can be used for any textual 
work, regardless of subject matter or whether it is published as a printed book. We recommend this 
License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the 
copyright holder saying it can be distributed under the terms of this License. Such a notice grants a 
world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated 
herein. The "Document", below, refers to any such manual or work. Any member of the public is a 
licensee, and is addressed as "you". You accept the license if you copy, modify or distribute the work 
in a way requiring permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a portion of it, 
either copied verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals 
exclusively with the relationship of the publishers or authors of the Document to the Document's 
overall subject (or to related matters) and contains nothing that could fall directly within that overall 
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not 
explain any mathematics.) The relationship could be a matter of historical connection with the subject 
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or with related matters, or of legal, commercial, philosophical, ethical or political position regarding 
them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of 
Invariant Sections, in the notice that says that the Document is released under this License. If a section 
does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The 
Document may contain zero Invariant Sections. If the Document does not identify any Invariant 
Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-
Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover 
Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose 
specification is available to the general public, that is suitable for revising the document 
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs 
or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters 
or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in 
an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart 
or discourage subsequent modification by readers is not Transparent. An image format is not 
Transparent if used for any substantial amount of text. A copy that is not "Transparent" is called 
"Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo 
input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-
conforming simple HTML, PostScript or PDF designed for human modification. Examples of 
transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats 
that can be read and edited only by proprietary word processors, SGML or XML for which the DTD 
and/or processing tools are not generally available, and the machine-generated HTML, PostScript or 
PDF produced by some word processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are 
needed to hold, legibly, the material this License requires to appear in the title page. For works in 
formats which do not have any title page as such, "Title Page" means the text near the most prominent 
appearance of the work's title, preceding the beginning of the body of the text.

The "publisher" means any person or entity that distributes copies of the Document to the public.

A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ 
or contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ 
stands for a specific section name mentioned below, such as "Acknowledgements", "Dedications", 
"Endorsements", or "History".) To "Preserve the Title" of such a section when you modify the 
Document means that it remains a section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License 
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applies to the Document. These Warranty Disclaimers are considered to be included by reference in 
this License, but only as regards disclaiming warranties: any other implication that these Warranty 
Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, 
provided that this License, the copyright notices, and the license notice saying this License applies to 
the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of 
this License. You may not use technical measures to obstruct or control the reading or further copying 
of the copies you make or distribute. However, you may accept compensation in exchange for copies. 
If you distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display 
copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, 
numbering more than 100, and the Document's license notice requires Cover Texts, you must enclose 
the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the 
front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly 
identify you as the publisher of these copies. The front cover must present the full title with all words 
of the title equally prominent and visible. You may add other material on the covers in addition. 
Copying with changes limited to the covers, as long as they preserve the title of the Document and 
satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones 
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either 
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each 
Opaque copy a computer-network location from which the general network-using public has access to 
download using public-standard network protocols a complete Transparent copy of the Document, free 
of added material. If you use the latter option, you must take reasonably prudent steps, when you begin 
distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus 
accessible at the stated location until at least one year after the last time you distribute an Opaque copy 
(directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing 
any large number of copies, to give them a chance to provide you with an updated version of the 
Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 
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and 3 above, provided that you release the Modified Version under precisely this License, with the 
Modified Version filling the role of the Document, thus licensing distribution and modification of the 
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the 
Modified Version:

 A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, 
and from those of previous versions (which should, if there were any, be listed in the History 
section of the Document). You may use the same title as a previous version if the original 
publisher of that version gives permission. 

 B. List on the Title Page, as authors, one or more persons or entities responsible for authorship 
of the modifications in the Modified Version, together with at least five of the principal authors 
of the Document (all of its principal authors, if it has fewer than five), unless they release you 
from this requirement. 

 C. State on the Title page the name of the publisher of the Modified Version, as the publisher. 

 D. Preserve all the copyright notices of the Document. 

 E. Add an appropriate copyright notice for your modifications adjacent to the other copyright 
notices. 

 F. Include, immediately after the copyright notices, a license notice giving the public permission 
to use the Modified Version under the terms of this License, in the form shown in the 
Addendum below. 

 G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts 
given in the Document's license notice. 

 H. Include an unaltered copy of this License. 

 I. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least 
the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If 
there is no section Entitled "History" in the Document, create one stating the title, year, authors, 
and publisher of the Document as given on its Title Page, then add an item describing the 
Modified Version as stated in the previous sentence. 

 J. Preserve the network location, if any, given in the Document for public access to a 
Transparent copy of the Document, and likewise the network locations given in the Document 
for previous versions it was based on. These may be placed in the "History" section. You may 
omit a network location for a work that was published at least four years before the Document 
itself, or if the original publisher of the version it refers to gives permission. 

 K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the 
section, and preserve in the section all the substance and tone of each of the contributor 
acknowledgements and/or dedications given therein. 

 L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. 
Section numbers or the equivalent are not considered part of the section titles. 

 M. Delete any section Entitled "Endorsements". Such a section may not be included in the 
Modified Version. 
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 N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with 
any Invariant Section. 

 O. Preserve any Warranty Disclaimers. 

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary 
Sections and contain no material copied from the Document, you may at your option designate some or 
all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the 
Modified Version's license notice. These titles must be distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains nothing but endorsements of your 
Modified Version by various parties—for example, statements of peer review or that the text has been 
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a 
Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of 
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) 
any one entity. If the Document already includes a cover text for the same cover, previously added by 
you or by arrangement made by the same entity you are acting on behalf of, you may not add another; 
but you may replace the old one, on explicit permission from the previous publisher that added the old 
one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their 
names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms 
defined in section 4 above for modified versions, provided that you include in the combination all of 
the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant 
Sections of your combined work in its license notice, and that you preserve all their Warranty 
Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant 
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same 
name but different contents, make the title of each such section unique by adding at the end of it, in 
parentheses, the name of the original author or publisher of that section if known, or else a unique 
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license 
notice of the combined work.

In the combination, you must combine any sections Entitled "History" in the various original 
documents, forming one section Entitled "History"; likewise combine any sections Entitled 
"Acknowledgements", and any sections Entitled "Dedications". You must delete all sections Entitled 
"Endorsements".
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6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this 
License, and replace the individual copies of this License in the various documents with a single copy 
that is included in the collection, provided that you follow the rules of this License for verbatim 
copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this 
License, provided you insert a copy of this License into the extracted document, and follow this 
License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or 
works, in or on a volume of a storage or distribution medium, is called an "aggregate" if the copyright 
resulting from the compilation is not used to limit the legal rights of the compilation's users beyond 
what the individual works permit. When the Document is included in an aggregate, this License does 
not apply to the other works in the aggregate which are not themselves derivative works of the 
Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the 
Document is less than one half of the entire aggregate, the Document's Cover Texts may be placed on 
covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the 
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole 
aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document 
under the terms of section 4. Replacing Invariant Sections with translations requires special permission 
from their copyright holders, but you may include translations of some or all Invariant Sections in 
addition to the original versions of these Invariant Sections. You may include a translation of this 
License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you 
also include the original English version of this License and the original versions of those notices and 
disclaimers. In case of a disagreement between the translation and the original version of this License 
or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", the 
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under 
this License. Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will 
automatically terminate your rights under this License.
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However, if you cease all violation of this License, then your license from a particular copyright holder 
is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates 
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some 
reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright 
holder notifies you of the violation by some reasonable means, this is the first time you have received 
notice of violation of this License (for any work) from that copyright holder, and you cure the violation 
prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have 
received copies or rights from you under this License. If your rights have been terminated and not 
permanently reinstated, receipt of a copy of some or all of the same material does not give you any 
rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation 
License from time to time. Such new versions will be similar in spirit to the present version, but may 
differ in detail to address new problems or concerns. See https://www.gnu.org/licenses/.

Each version of the License is given a distinguishing version number. If the Document specifies that a 
particular numbered version of this License "or any later version" applies to it, you have the option of 
following the terms and conditions either of that specified version or of any later version that has been 
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version 
number of this License, you may choose any version ever published (not as a draft) by the Free 
Software Foundation. If the Document specifies that a proxy can decide which future versions of this 
License can be used, that proxy's public statement of acceptance of a version permanently authorizes 
you to choose that version for the Document.

11. RELICENSING

"Massive Multiauthor Collaboration Site" (or "MMC Site") means any World Wide Web server that 
publishes copyrightable works and also provides prominent facilities for anybody to edit those works. 
A public wiki that anybody can edit is an example of such a server. A "Massive Multiauthor 
Collaboration" (or "MMC") contained in the site means any set of copyrightable works thus published 
on the MMC site.

"CC-BY-SA" means the Creative Commons Attribution-Share Alike 3.0 license published by Creative 
Commons Corporation, a not-for-profit corporation with a principal place of business in San Francisco, 
California, as well as future copyleft versions of that license published by that same organization.

"Incorporate" means to publish or republish a Document, in whole or in part, as part of another 
Document.

An MMC is "eligible for relicensing" if it is licensed under this License, and if all works that were first 
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published under this License somewhere other than this MMC, and subsequently incorporated in whole 
or in part into the MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated 
prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the 
same site at any time before August 1, 2009, provided the MMC is eligible for relicensing.
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 APPENDIX SIX –   Misc: Turnpoint files, splash images 

Turnpoints -  If you look in the top folder of your landscape, you will find a <landscape>.cup (just put 
your turnpoints in that file). 

Splash Screen Images – These are displayed while Condor2 is loading your landscape.  Theses are 
stored in the <landscape>\Images folder (just check Slovenia), they are .jpg, 1920x1080, and use a 
number for the name.  It will cycle thru them.

Below are some other notes on turnpoint usage and  formatting:

*  On your first use of a landscape the turnpoints are loaded from
   a file in the landscape directory with the name <landscape>.cup

*  After first use Condor stores a copy of the turnpoints in a
   file located in Documents\Condor\Turnpoints\<landscape>.cup
   It then uses that file exclusively and ignores any changes you
   might make to the turnpoint file in the landscapes directory.

*  If changes are made to the turnpoints file in the landscape
   directory with a new release of the landscape, you must delete
   the turnpoint file in the Documents\Condor\Turnpoints folder
   first before starting Condor.  It will then use the new file.

*  Visibility of turnpoints depends on the "Style" field being a '1' in
   the turnpoints file followed by no other data.  If something is not
   showing up, try changing the value, perform the steps above,
   stop/start Condor, and it should appear.  Example:

Before:
"Yadkinville","YADKNVLL",US,3608.550N,08043.083W,1050ft,3,,1200ft,,"Turn Point, 
Landable, Land to the East, RW width: 50"

After:
"Yadkinville","YADKNVLL",US,3608.550N,08043.083W,1050ft,1,,,,

*  You can create your own turnpoints in the Flight Planner by clicking
   right and selecting "New" -> "Turnpoint".  Those will be stored in
   your Documents directory copy only.
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      APPENDIX SEVEN: Notes on object creation/placement

From: Nick Bonniere: 

 “They wanted two windsocks.  I used the Airport Maker tool to create the simple grass runway and 
one windsock.  I then made some edits to the NorthPlains.obj file (in the Airports folder) and 
thought it would be easy to add another windsock -- it wasn't! “

 Although it sounds simple to generate two files from the Airport Maker, one with each windsock at its 
desired location, and merge the two files, it is actually complicated because the .obj format uses 
absolute indexes instead of relative indexes to each object (winsack and pole), and you'd have to 'add' 
offsets to all vectors.  It is not really feasible.

I suggest you use the .px format and use Condor_Tiles to convert it to c3d.  It is easy to merge two or 
more .px files. 

If you want multiple objects in an object file xxxO.px, or for that matter multiple grass and asphalt 
runways in a xxxG.px file, you simply create each object.px and then simply copy/paste the whole text 
(except 'xof 0303txt 0032') and append it to other objects. 

Each object (frame) should have its own name. You can do a global search-and-replace to change 
names before concatenating objects.

There should only be one 'xof 0303txt 0032' at the beginning of the file containing all the objects.

You can have up to 3 wind socks in a landscape and the names MUST be Windsack1, Windsack2, 
Windsack3.  Each would be at a different location and can have different pole size, and windsock size. 
With each wind-sock, there is a mast. The name of each mast is not critical, but usually Mast1, Mast2, 
Mast3.

I believe you can add a comment with // on a line by itself, but not the very first line which must start 
with 'xof'.

You then convert the .px file to .c3d with Condor_Tiles.

The simple objects are all at the centre of the runway to start with. You can move each one to the 
desired location with Condor_Tiles. In Object View, when you expand each frame and click on the 
mesh, it activates the edit buttons 'Centre', 'Rotate', and 'Move'. The 'Centre' button moves the mesh 
back to the centre of the runway. The 'Rotate' button rotates the object a number of degrees (relative to 
its current rotation) as specified in the box next to the button. The 'Move' button moves the object 
(relative to its current location) in X (left/right, left is a positive number), Y(up/down, up is a positive 
number), and Z (elevation), with the three input boxes below the button. This is a tricky operation.

In the new Condor_Tiles version, it is also possible to move an object by adding a ‘Frame-Transform-
Matrix’to each object defined in a .px file format.
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     “They takeoff on a paved runway, but land in the desert.   Joes been working on trying to put a 
real runway down that matches the desert.  It looks good from high, but when you get close to 
landing, it turns green. “

                                             Yes, that's the way the 'grass' feature works, the detailed grass texture only 
showing when getting quite close to the runway. At altitude, there is no point as you can't see 
individual grass blades anyway.

If the runway is not grass and/or not green, and you don't want grass details, just don't put it in the file, 
i.e. remove the mesh named 'grass'. You can still have a mesh 'asphaltpaint' which looks like crackled 
paint to show an outline and marks on the dirt runway.

Condor treats objects with the mesh names 'grass', 'asphalt', 'grasspaint', 'asphaltpaint' with a special 
meaning and are treated differently. These meshes are painted over with a 'tiled' texture, and the 'grass' 
details only shows at low altitude.

If instead of a mesh called 'grass', you name it 'dirt_runway', the special 'grass' texture is not used and 
instead, the object's RGBA 'color' is used and painted over the runway. If you specify a filename for 
this mesh, such as 'dirt_runway.tga', this file will be used instead of the object's color, and the area 
specified by the texture coordinates will be stretched over the runway. This is the same as for any other 
object.

If you use the mesh name 'grass', and also specify a filename for this mesh, such as 'rnwy-09-27.tga', 
this texture file will be stretched over the runway, and the 'grass' will also appear as you get close to the 
runway.

If you've read Xavier's Airport write-up, you may have seen the mention of a 'muck' file, i.e. a texture 
file with the suffix '_muck'. I am not entirely clear if this is treated any differently than a regular file 
without the suffix. It seems that this file can be applied to the 'grass', 'asphalt', 'grasspaint', 'asphaltpaint' 
areas and modify the tint and brightness, and it may be possible to get yellowish grass for example, and 
yellow paint markings instead of white. 

It is also possible to create a runway texture file, that was created by close-in screen-captures of the 
runway from hi-res imagery. That is another way to enhance the runway details, by basically using 
higher resolution imagery for the runway. 
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APPENDIX EIGHT:  High Resolution – whole tiles
From: Nick Bonniere

It is possible to improve a scenery with higher resolution for some tiles, i.e. 16384 instead of 8192. In 
Condor_Tiles, you can try if you want, just type in 17 for zoom level, and 16384 for tile size. (You 
can't select it, you have to type it in).  You can select just one tile or do the whole scenery. You can 
also just do one-quarter tile too. Each tile is sub-divided into 4x4 sections for a total of 16 small tiles 
which I call 'quarter-tiles'. 

The landscape editor cannot be used for exporting DDS tiles, you have to use the DDS batch file 
instead. It is because the program nvdxt does not work properly with defaults and needs a parameter 
change for 16384.  nvdxt also has issues with 'water puddles' in dxt1. 

Zomm level 19, size 32768, is the limit when using the Nvida tools, for more Compressonator is 
necessary.
  

 If you want to change one of the tiles in a landscape to a higher (or lower resolution), you have to 
create new  GMID and GDAL and DDS batch files for this tile.

First you select the landscape and read the header as usual. Then you pick the tile you want to update in 
the tile pull-down box, such as 0000 for example. You select the zoom level in its pull-down box, and 
if you want zoom that is not showing, you type it in such as 17 for example. You also need to select the 
tile size in its pull-down box, and if you want a size that is not showing you type it in, such 16384 for 
example. You then click on the Make GMID and Make GDAL buttons to generate the batch files. 

You then go to the tile folder, such as SourceFiles/0000 and click on the 'Batch_Download_0000.bat' 
file, and it will trigger the downloading and combining as before, but 

it will take longer for higher-resolution.

NOTE: the Batch_Download only does the download. You need to do the Batch_Combine before you 
can run the GDAL_0302.bat 

Once the download/combine is done, you click on the GDAL_0000_3857.bat file to convert the tile to 
UTM.  Then use the “Make DDS” button to create a DDS bat file used to make the final textures.

Once the UTM conversion is done, you need to generate the DDS textures.  Instead of using the 
landscape editor and exporting the textures, You click on the DDS_0000.bat file. The 16 Texture files 
will then be automatically generated, and when done you can fly the landscape. No need to do anything 
with the landscape editor.

I have limited the range of zoom and tile size on purpose as going beyond the ranges shown takes a lot 
of resources, but for those who know what they are doing, the zoom level and tile size can be set 
beyond the limits.
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APPENDIX NINE:  Adding/merging to an existing scenery

From: Nick Bonniere

“How to grow an existing scenery without re-doing already created tiles”

To maintain the same bottom right hand corner UTM coordinates, you do NOT change the lat and long, 
but adjust the UTM coordinates instead in the DEM helper panel.

For one tile west, you subtract 23040 from the UTM west. for one tile north, You add 23040 to the 
UTM north coordinate, and then click on check/show to see the result.

  

To be able to merge two landscapes, the UTM zone number must match and the UTM coordinates must 
be on the same Condor tile grid, i.e. offsets must be multiples of 23040, i.e. the same as if 'growing' an 
existing landscape. 

 To join landscapes, the numbering is quite simple. Each Condor tile has been split into 16 patches, i.e. 
4x4.  tile 0000 has been split into 0000 0100 0200 0300 horizontally and 0000 0001 0002 0003 
vertically, with 0303 as the opposite corner. The first two digits are column numbers and the second 
two, are row numbers starting at the bottom right. So all you have to do is re-number according to a 
new 0000 reference you chose.

You can have a zigzag border. Missing tiles are filled in by Condor with a default tile. In Condor V1 
there was a dds tile called empty.dds that was used for missing tiles. I believe this can still be used if 
you want to add a generic empty.dds tile. I have not checked in V2. You can try removing a tile and see 
how Condor deals with the missing tile, and you can add an empty.dds tile and see if Condor uses it to 
fill the missing tile.

Although the re-numbering of the tiles can be done simply, and tiles combined into one folder, there is 
more to it than that. All other files have to be merged too. Some like the .CUP file can be done easily, 
the .APT file too, but others are more difficult to merge, such as the thermal map .TDM, the object 
file .OBJ, the terrain file .TRN, the AIRPORT folder, etc... 

For now, there is a way to merge two sceneries that use the same UTM zone and same grid reference 
(multiples of 23040).

To avoid downloading, combining and converting to UTM and exporting to DDS, the same tiles can be 
re-numbered with a script and this avoids a lot of time. 

For the rest, you can create a 'new' scenery with a new name from scratch that encompasses the area of 
both sceneries by selecting appropriate UTM extents, doing a 'check/show' and doing a 'make DEM'.
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Then after getting the elevation data do a 'make terrain .trn' and 'make terrain .tr3' as for a new scenery. 
Now, however, you just use the re-numbered tiles in the Landscapes\NewName\Textures folder. You 
still have to 'flatten' the airports, etc... but you avoid re-downloading and processing all the tiles.

There is also another way that uses the Landscapes\NewName\Working\Terragen\Textures files. You 
can re-number these tiles with a script. It is simpler since there are 16 times fewer tiles. You then need 
to use the Landscape Editor to import these textures, and export them to DDS.

There is yet another way. Create a new scenery as above, and merge the 'Tile' folder from both land-
scapes (Landscapes\Name_2\Working\SourceTiles\Tiles, 
Landscapes\Name_2\Working\SourceTiles\Tiles) into the 
Landscapes\NewName\Working\SourceTiles\Tiles folder. These are the raw downloaded files. This 
only avoids re-downloading all the tiles. You still have to combine them and process them, and the rest.
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APPENDIX 11:   Fixing artifacts in satellite imagery
Especially in the Airport area it’s not unusual to capture vehicles or aircraft that are on or next to a 
runway at the moment the satellite took the photo.

Some can be ignored, but there is a ‘relatively’ simple procedure to 
remove them. 

In this example I created a hi-res quarter tile around an airport.  It 
captured a glider waiting for takeoff next to the runway, not one that 
had been run over by a steam roller!

A little background:  The satellite imagery is download and 
corrected for aspect.  Eventually a Windows .bmp file is created that 
capture the image at the proper size for the full tile or quarter tile.

The next step in processing combines the .bmp file with terrain 
elevation to create a 3D Texture, a .dds file.

We will fix the .bmp, and then simply re-run the batch job that creates the final.dds.  I’ll first illustrate 
the steps used when fixing a quarter tile.

1)  Find the .bmp that needs edits.

Since you followed the earlier steps under “Optional Processing” in this tutorial, you should know the 
tile number.  In this case the location is: 
/Condor2/Landscapes/masa/Working/SourceTiles/0402/QuarterTiles/t1608.bmp

Now this is a LARGE file, over 800 MB.  You can next use the image 
editor of your choice to make the correction.  I won’t go into a lot of 
detail here since every editor is different.  My tool of choice is Gimp 
(free software), pretty close to Photoshop in capability.  It has a 
‘clone’ tool which makes it easy to blend the background.  HIGHLY 
RECOMMENDED – make a backup copy of the .bmp file in case your 
edits go wrong.

After the image has been corrected, the .dds texture file is created by 
running the DDS_0402_00_00.bat (same as in the steps for the hi-res 
tile).

The resulting t1608.dds is then copied to the “Textures” directory for 
your landscape, in my case:
/Condor2/Landscapes/masa/Textures/

It will take effect immediately on your next flight.
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